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What's New?
The following are the key changes in this version 2.5

1.

o 1A W

Better installers on both Macintosh and Windows. Recognizes
Windows versions, more easily installs on 0SX, and other
things making installation and startup smoother.

Uninstallers on both platforms as well

On both platforms, an icon is put on the desktop for you.
The KP horary feature was fixed.

The KP chart printout responds to your font settings now.

The bug on Windows where the chart was sometimes covered
by a square has been fixed. (You can no longer minimize that
window however)

And the main thing: The Panchang and Entries/Exits features
have both had their data extended well into the future.

“The Back Door” button was moved, so those who were given
this previously will not immediately have it again.

The following were key changes in the previous version 2.26

8.

9.

ACS Atlas on Mac now, integrated fully in both platforms- all features now
always time-correct no matter what.

Online Help throughout the program now, with pictures and related
articles. You will see Help buttons on most windows.

Vastly upgraded user manual online in program, as well as in Acrobat
form.

Stretchable windows and charts- yes, this is great, you can now stretch
windows, and almost everything grows, so if you have a big monitor
especially, you're going to be really happy about this.

Improved reading when clicking planets on main chart windows: You can
now get readings for Bhava and Navamsa charts, and all the other Varga
charts.

Click and get readings on Styles A and B now. Previously, on Style C
windows only could you click on the planets and get readings right there.
Now it works on Styles A and B as well.

Wheel charts on Styles A and B- those of you who like wheels will now get
wheels if you choose styles A or B.

More artistic chart windows- you will love these portals to beauty as you
study charts on them.

Change font and font size on most text areas such as readings, on most
important windows.

10. Imports data from Parashara’s Light.



11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Characteristics for all the famous charts. We had an associate go through
all now 3,200 famous charts and add at least one, but sometimes 2 or 3,
“Characteristics” to each chart. Characteristics is a feature that was
already in the software, but is now really useable because of this addition.
Characteristics are one or two words that describe something about the
person, usually their career, or things they are famous for. Examples:
President Clinton would get “President” as well as “Politician”. Pamela Lee
Anderson might get “Model” and “Sex Symble”. I would get probably
“Programmer” and “Astrologer”. So in this way, you can now know, with
this upgrade, that all the famous charts included are now searchable by
keywords as above. So you can instantly get lists of charts based on
keywords for your review or research. You can looks at models,
murderers, auto makers, presidents, army officers, religious leaders,
Indian Gurus, WHATEVER!.... there are at last count nearly 600 different
categories to choose from.

New famous charts, including more charts of current and recent interest
making the total now 3,200 people, along with the already existing roughly
1000 cities and countries dates of incorporations charts.

Lots of Basic Jyotish reference tables included in a pop up window
including tons of information on the Nakshatras taken from many sources.
You can now rebuild the data in the entries/exits (movements) feature to
suit your taste in ayanamsa and date range, you can also do this but instead
output the data, so now you can create an entries/exits text file for your
selected date range/ayanamsa.

You can now add/edit cities into the built in ACS Atlas, including linking
the new city to a pre-existing ACS time table.

You can now set a standard color pallette for the charts on the main chart
windows styles A, B and C. You can set the background color of charts, the
lines, and the signs and planets glyphs all individually, so that Jupiter is
always one color, Gemini always a certain color, and so on. You are able to
choose from a large color array. You can save your settings, and they will
always be used.

Now when you move your mouse over a planet in the chart on Styles A and
B you are given information about the planet instantly. If you click, you get
quick readings, and also the aspects of the planet and it’s lordships will
blink in the chart quite clearly, showing you where the planet aspects and
lords.

The Roster window from Version 1 was added back to Version 2 because
so many folks missed it’s simplicity and sorting capabilities.

Furthermore, on the “Sort” menu that appears on chart windows Styles B,
C, S, and as well the “Chart List” window which is always available under
the “Main” menu, there has been added sorts of the main chart list (present
on all these windows and others) by the Planets Signs, Degrees and
Houses, and also a powerful new “Complex Sorts” menu line, which pops
up a window which allows you to build complex sorts from all the 60 or so
available fields.

A new color report was added. This one is nice because it has pictures of
Radha-Krishna, Vishnu and Siva on it.

For those who use the Northern Chart format and like to use the Chandra
Lagna chart, there is good news. You can now set an option on the “Other
Prefs” window which tells the program to print the Chandra Lagna chart

Goravani Jyotish



instead of the Bhava on the main chart printouts (the one’s that Show Rasi,
Navamsa and Bhava).

22. If you enter a City, State and Country for the chart subject’s “Current
Residence” on the “Address/Note” window, then that city you enter there
is used as their “Current Location” when accessing windows like Transits,
Panchang, and Varshaphal.

23. Number Horary or “KP Horary” was added.

24. Similarly, but different, is a new feature which allows you to set the
ascendant for a chart to any exact point in the zodiac that you enter. This is
useful for creating “Chandra Lagna Charts”.

25. Sidereal Asteroids were added.

26. Advanced ayanamsa preferences and controls were added. Although you
can ignore this new feature completely, and the program will feel no
differently to you, if you want to now you can control the ayanamsas much
more carefully. We added the ability for you to control the internal
ayanamsa settings- entering your own figures for all the ayanamsas as you
wish. Besides being able to set the year of alignment and yearly rate of
precession, you can also enter tables of check point dates and ayanamsas,
or what I've chosen to call “adjustment dates and ayanamsas”- which are
essentially nothing more than a date and the corresponding ayanamsa for
that date.

27. Complete Transit Hits feature. Fully configurable, wide range, many points
of hit spots to track. Add your own points too. I think this is the most
awesome transit hits finding, listing, and printing feature that one can
possibly dream of.

28. New Moon, Full Moons and Eclipses Listing Window.

29. Hindu Months in the Panchang, along with Sunrise times, and a number of
new ways to output Panchang information.

If you are Upgrading, Read This!

Note: New as of Version 2.5: This version, 2.5, no longer over-
writes your old datafile as previous versions did, so, you can tend
to the following matter later if you want. On Windows, what it
does now is RENAME your old datafile, appending the word “old”
to its name. On the Mac, the folder created now is not the same
name as the old one, so, your old installation is not overwritten. It
is advise-able however that you delete the Omnis 7 out of the old
folder, so as not to have two of the Omnis 7 icons on your
Macintosh, which can create problems. But you can and should
leave your old Datafile in the old folder, so you can access the
charts in it later. To switch between datafiles, you use the
“Change/Select Datafile” command under the File menu inside the
GJ] program. In other words, you run the program, then you pull



down the File menu to that line, and select either datafile, and as
detailed below, you can export and import between datafiles.

If you are upgrading, then you need to answer one question: Do
you have charts entered in your current copy of Goravani
Jyotish, which you could not easily re-enter into the new
version either because you've entered many, or you don’t
want to have to re-enter them. If you answer YES to this
question, then you need to export the chart data from your
current copy of Goravani Jyotish, for importation into the new
upgraded copy.

If you can easily re-enter the charts you have currently entered,
then don’t both with the export and import process. But if you do
want to save some charts, then you have to do the export/import.

Basically, the process goes like this: You export the birth details
for the charts you currently have entered. This creates a “text file”
on your disk (floppy or hard disk) which contains the birth details
for the charts you want to save. You then install the new Goravani
Jyotish, and after it’s running, you select the “Import charts”
feature and select the file of birth details you created, and they are
brought into the new version. It’s that simple, though it takes a
number of steps as follows.

Exporting Charts Data

You may wish to watch the Explmp.exe movie about exporting
and importing charts in the “Movies” folder on the CD. Just double
click on it to view it. (Hopefully your machine will show the movie
and play the sound for you. If not, sorry, we can’t get involved in
debugging machines for multi media purposes. In that case, just
continue with this manual- it's complete by itself.)

Steps:
Go into your current copy of Goravani Jyotish.

If it's a version 1 copy, go under File to Tools to Export Charts.
Then select the charts you want from the list (you can use “Select
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All” under the Edit menu if you want them all). You can highlight
certain ones by holding down the Control key (on Windows) or
the Command key (on Mac) and then clicking one by one on the
charts you want.

or

If it’s a version 2 copy, then do this: Go to the File menu, then to

“Export/Import”, and then under the pop out menu select “Export
All Charts”.

On version 1, be sure to select “Birth Details Only” as the file
format. Do not select “Complete chart” because importing
that format is not available in Version 2 and later of Goravani
Jyotish. Use ONLY the “Birth Details Only” format.

You will then be allowed in both cases to save a text file
containing the birth data for the charts you have selected to
export. This is what such a “file save” dialog window looks like:

Notice that you can name the file, and
the default is “print file”, which is
misleading. Rename it “Charts.txt”".

Important: Remember where you are
saving this file, and what you've
named it. The TXT extension is a
good one to use on Windows machines. The important thing is to
remember where you are putting it, and the name you are giving
it, or allowing it to have. Notice that the above window shows you
what folder and drive you are putting the file in and on. Simply
take good notice of the names it is showing you. You WILL NEED
TO KNOW this information later.

Since you are exporting your charts from an old version, there's a
good chance you are going to want to throw out that old version,
at least after the new one is running fine for you. So, be careful
about putting your chart export text file in the old version folder,
as it may get thrown out with the rest of the folder, should you do
that later. It’s just a thought- think about where you are saving it.
Putting it on a floppy is a good idea if you're unsure where to put
it.



So that covers getting your charts OUT OF your old copy. After
you have installed the new version of Goravani Jyotish, you can
then import those charts into the new version. So now get the
new program installed, and when it's working normally, use it’s
Import Menu line as detailed later in this booklet.

Movies on the CD

There are training movies on the CD in the “Movies” folder. Open
that folder and double click on the movies. There is a list there
also which tells you what each movie contains. Double click on the
list called “Movies.txt”. There are movies covering installation.
You can watch them before doing the following installation to get
acquainted if you like. You can also watch the Explmp.exe movie
about exporting and importing charts.

Installing GJ on MS Windows (all versions)
For Macintosh, see the next section.

1. Run Install.exe on the Goravani Jyotish CD

Select “Run” under the Start menu, then type D:\INSTALL
into the “Run” window. (use your CD letter if it isn’t D, ie, try E if D

doesn’t work) or, just open the CD and double click on
INSTALL.EXE. Open “My computer” then the CD, then Install.

Now be patient and wait for the installer to come up!
3. Then approve the C:\GorJyoV2 destination. (It’s best)
4. Then approve the Goravani Group Start Menu Programs Group.
5. It will then run through the installation of GJ.
6. Reboot after the installer finishes. This will activate your fonts.

9. Run the program by the icon on your desktop or from the Start menu,
to Programs, to Goravani Group, to GJ 2.5

10. If you get " Change/Select Datafile" (if it comes up) select
Data_Med.df1. Do NOT create a new datafile (it wont work!) Most
will not be asked to “Change Datafile”- this window will not appear
usually.
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11.If a demo, click “Run in Demo Mode”. If you purchased the program,
click the activate button, and then call for an activation code (or
use e-mail as described on the activation window).. If we sent you a
separate sheet for self-activation, follow those instructions instead-
they’re better than sending/calling for a code.

12.You're in- enjoy the program. Be sure to read the manual.

13. If the fonts look wrong on the windows in the program, i.e., they
look too large and overrun their allotted locations and boxes, or
don’t look like they did in old versions, etc., then, it may be that
they fonts did not go into the system correctly. We have noticed
this behavior on XP. If so, open your system fonts folder through
Setup, Display Control Panel, and see Accujen, Accumon, and
Accushi. These are our 3 main fonts besides “Jyotish” which
doesn’t suffer this problem. Simply highlight the three fonts
beginning with “Accu”, then do a cut, then a paste. This will cut
them out of the fonts folder, then paste them back in. This will
cause Windows to run it's OWN font installer upon them, which
tends to fix the problem.

14. See “Activation or Demo” following the Macintosh instructions.

Installing GJ on the Macintosh

This installer works on 68000 machines (old ones), PPC
machines, and the latest G3,4,5 machines, and systems 8 through
OSX including Panther, as of the time of this writing. It may well
work on later versions of OSX also.

Because the folder has a new name, it will not replace your old
folder. So your datafile will still be there. You can export your
charts from it and import them into this version. You may have
problems if you leave your old folder on your system however. |
would delete it except for the Datafile contained inside it. Keep
that to get your old charts. You can log into that datafile from the
new program by going under the File menu to "Select datafile".
Then export the charts. Then log back into the new "Datafile”
inside the new GJ 2.5 folder, and import the chart file you just
created.



Special Notes for OSX Users
Others, skip down to “Installing”

This version of Goravani Jyotish, 2.5, runs in Classic mode of OSX.
So you have to have System 9 installed on your machine, for
Classic mode to operate. This is most likely the case already. You
no longer need a patch for OSX with this version. It's been pre-
applied.

[ am working on the new version, which is OSX native. [ am
bringing it out still, and I'm closer than ever (as of this writing).
Eventually this will be old information. [ may already be out with
it as you read this (written October 2004)

On 0OSX, the installer places the “Goravani Fonts”, which are Fonts
needed for the program to appear correctly, in an unusual
location. It puts them in the Fonts folder associated with the
current user. On 0SX, each user has an identity, even if you are the
only user on the computer and you never have to “log in”, you still
have a “user” folder. In this folder, or in any user’s folder, is a
Fonts folder. This is where the Goravani Fonts are installed. This
works, and the fonts will be available for GJ to use. The main fonts
folders are somewhat “off limits” to installers, and I wasn’t able to
make that work, so I had to go for this option instead. This
paragraph is just letting you know this. There’s nothing you need
to do about this.

Printing on OSX

Be sure to log into your classic version, boot from system 9 or just
go into classic mode, and see if you can print from other programs
there. Make sure that your printer is visible in the system 9
chooser. You may have to install print drivers, or get print
drivers, for your printer for system 9, and make sure they are
visible in the chooser, and selected, and then my program has a
better chance of being able to print.

Installing
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Insert the CD, open it, and run the Installer on the CD.

There are a couple windows that are standard that you click OK
on. Much of what is written on the first window I repeat here. The
second window, the “License” is for humor purposes mainly.

Then a window appears that you just click Continue on. If you
want to uninstall, you can go to “Custom” and select that. But if
you are installing (the normal case), just click Continue or Install
or Go or OK, whatever the positive button in the lower right
corner is.

Also, when the window pictured below appears, it's only asking
you where to put the software. DO NOT click the "new folder"
button. You don't need to. Just hilite the disk, or folder, within
which you want it to place a folder it will create called GJ 2.5.

So just hilite your disk, and a folder within your disk, and then
continue.

Selett aily WHERE b= past the folder. B i credted foi

Fram : EEA |
= T A &
= il Bk E
o aa Cors
H e Corporanions
Cexkiog Folder
-\.:"'.l .-I
Ll
iy Fralidi Add e Favarites

L i

Cance £ Choose Y

Although this is the OSX version of the window, those of you on
System 8 or 9 will get a similar window, and should heed the
same advice.

After this, it just installs the program. If you get an error, on 0SX,
it’s because you didn’t unlock the System yet. Read above about
OSX for how to handle that.



At the end of the installation it should come up with a dialog that
says “Installation was successful”.

This installer will put an icon on your desktop. Just double click it

to start the program. It’s a green ball that says “Goravani Jyotish
2.5

Activation or Demo ?

The program will present you with a window which checks if you
are a demo user, or someone who has purchased the program and
needs their activation code. If you are viewing the demo only,
then click the “Run in Demo Mode” button. If you have purchased
the program and want to activate it now, then click that button.
You will have to call or e-mail us for the code. Read the window
that appears for more information on this process and the best
times and strategies for activation.

The previous "Back Door" is no longer where it used to be. Users
will have to ask for activation codes, or the new back door, and in
both cases, be sure to fully state who you are with the name you
purchased the program with. I do need to try to protect myself
from pirating of my program. Thanks for understanding.

You will then come to the "Main Charts" window, which is the
main window of the program.

gl Main Chart Window Style A !EII!I 1
pors oo 2] S [ o | i | Th.e Main Chart
o e L, Jeledlest) Window Style A

Goldschmidt, Meil
Goldwater, Barry

DST/WT 0O, Allshabad,
, India, Tirme Zone 0. Mote | Features |

;I De]etel Open Charts I

d| The window shown
here is the main

B 4| window you work
Indira Gandhi ]| Planets Goto  [Moon - 265 days ) .
T = from. I lick
izt A1l Charts Abowe  Miew Many |c Emn 2 En 265 =60 rom. t S easy_ C IC
[ wiews [ pistances | < [ » [ upasrahas [ To Madhyas [ Sat  Jup  11/28/1385 B8 |-
Ein Sign Def’H .-"Se Star_ Otr Lord Guna Shasti :E"‘C EZZE ??::sg-;:ggg :r‘r‘g
e SELEAERE Alere ven'  trmariear 2 NEW tO enter d new

Sun 4 Scorpio 4% 21° 28" Aruradha Sat  Tama Garal

Merc  Sun 09/04/1994 76

48" Uttarasha 4 Sun Raja B Indu
Mars ] 29 9% Purwaphal Uen Raja Davag h t d bl l- k
Hercury corpio 35° 10” Aruradha 4 Sat Tama B kshit Merc  Rahu 101 C ar ) Ou e C IC
Jupiter B S Taurus 4% 557 32" Rohini TMoon Raja M Gul ik Mere Jup  06/25/2000 82
Uehus S Sagittar 21% 15° 17" Purwashad Uen Raja Utpat Merc  Sat 10,01 /2002 a4 - .
Saturn 3 Cancer 217 47° * Ashlesha Merc Satw Kaala Eetu  Eetu 06;10::2005 a7 On a Chart ln the llSt
Fiahu Sogittar 9° 1Z° * Hula Eetu Tama B Mridu Eetu Uen 11/06/2003 &7
Ketu Gemin 9® iz2* * Ardra Rahu Tama B Mridu d Ketu  Sun 01706 /2007 29 d

to bring it up, add
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charts to the list (like search the famous file) by using the Open
Charts button.

Using the On-line Manual

The new Acrobat format on-line User Manual will appear to you
onscreen in an Acrobat window like this one:

Acrobat Reader - [MANUAL.PDF] [_ [ X]
File Edit View Tools Window Help 18] x|
Bz 58 [ &fa@| <[« [m] «|»| D|EE )

: all X a
DD Basics :] ‘ -':-:-::5;:-:-:»'-:-:-:;5::-:-:»c-:-z:z::-F’mm-Das;;;-:‘-:-:-5:5-:-:-':-:-:-5;;-:-:-’:-::!

[ Ifyou are Upgradi— | Hello, welcome! Please learn to use this Acrobat program. Click on the

[3 Export Charts | titles at left. Use the buttons and Command Keys above- explore! You ca

) Importing Charts | search for words- click the binocular button above. Print this manual if you

P [ Installation
< [ Program Basics
[ Finding Charts
[ Enter Chart
[ Dont's
[) General Mattet
[ Command Kes
[) Report Destin:
[ Main Window
[) Features Acce
[ Buttans, bars
< [1 Customization
[ saving
[ stretchable Wi
[ Restoring ¥vin
[ Chart Colors
[ Coloring anyth
M Window Plairl.ﬂ I

o

Notice the table of contents on the left. When you click the lines
there, it take you to that section right away. You can also leaf
through the pages in any section, in order, one at a time, as you
would do when reading them straight through. Acrobat is
professional, and easy to use. | hope you enjoy and get much
benefit from this new format.

IS

IMPORTANT: Notice in the above picture, that a couple of the
triangles on the left are pointing down, revealing indented sub
directories under them- DO THAT - click those triangles to see
these indented subdirectories, or you'll miss out on huge sections
of important online information!

Said again: Notice the triangles on some of the table of contents
entries at left in the above picture. By clicking on these once, they
rotate open or closed. When open, they display the subtitles that
reside within them. This is a hierarchical table of contents in



other words. So be sure to click these arrows open to see what'’s
under them.

To use the on-line manual, just select it from Start, or double click
on it’s icon. You can view it onscreen, and from there you can
print it out. It is formatted for standard American Letter Size
paper (8.5 by 11 inches). If you print it to a color printer, then the
color screen shots will print in color, which is nicer than black and
white.

There are a number of other files for you to read and study. You'll
find Jyotish instruction, and spiritual matters, which may or may
not interest you. There are some interesting, never before
published tables of vargas and karakas, and other things,
contained in those files. You might want to spend some time
checking it out.

Importing Chart Data

This section assumes that you have exported charts into a file, and
that you know where that file is located and what the file is called,
either on your hard disk or on a floppy.

Select under the File Menu the Export/Import line then to “Import
Charts”. You will then see the following window:

importation Methad g| Select the appropriate
Type of file you wish to import: (select correct onel button. If you are

@ Goravani Jyotish . 1 Birth Details Only File . . .
Cre.ated by old versions of Goravani .le!otish _using the_ “Export Cha.rt Data" brlnglng ln Charts from a
option undet the Tools Menu and zelecting "Birth Details Only ™ option.

3 Goravani Jyotish U, 2 File 1
Created by ¥. 2 and later verzions of Goravani Jyotish (this copy of GuJ falls into this VerSlon 1 'X Copy Of
category]) using the “Export Charts" button or option under the File-Export Menus. . .

O Bluestar QuickCharts Farmat Goravani Jyotish, then
Created by recent versions of BlueStar.

) BlueStar QuickCharts Format with “Smart Filter" select the tOp button,
Irparts BlueStar's QuickCharts format but exeludes certain types of records. Specifically,
it will not allow i harts: 1. Prior to th 1800; 2. Haz a 7 [questi k] 1 1
Ingnea e astag 3 ess T 1 e o - e rr e e ness || WHicCh is already selected
it's England, in which cage it's conwverted to "GMT"; 5. Deletes duplicate records.

O 10 Series Format probably, because that is
Created by recent versions of 1.0, Software. [ Cancel ] [[ Proceed ]] f V . 1 f.l

or version 11e

compatibility. If you are
bringing in charts from a copy of Goravani Jyotish Version 2.x,
then select the next button down, which gives compatibility with
Version 2 chart files (version 1 and 2 have different formats).
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Then click the “Proceed” button. You will then get two messages
to which you simply click OK after reading them. You are then

faced with the standard file selection dialog which looks like this
or whatever your operating system shows (these things change):

Select import file EHE

| el The function is to to navigate on
Look in: N Goryo22 > 5| |5 2 . . .
1 Ephem (#)] Adhoc.gid %] Dadsc32.dI |2] 07tk16.dIl your dlSk(S) to flnd the flle that

) External & Adhoc.hip GlossawPDF  [3] 07tk32.dl

Fonts Bogbookror  Foowentr  Somud | YOU previous]y saved Containing

1 Helps Chaintr. PDF Jyotish.PDF Omnis7.ex

giees [Bbsavesan R Eowwec | the chart data. You have to use the
dq | » | buttons and menus on this or
Flosane. | [ 2= || similar window to find the chart
Files of type: IA[I Files (*%) 3 Cancel . .

file you previously saved from the

old version. Once found, open it.

You will then come to two windows whose purpose is to verify
that the chart data appears to be coming in correctly. You simply
look at the top window, then give your OK on a button on the
bottom window:

WCHART_IMPORTZ

- e mEEE me The top window shows the first
[ 5oz chart. If the data appears to be
lining up with the correct field

Examine Before Proceeding ! =]

Look at the first record to import which is shown above,

Whatever data is there (some is optional) should line up
with the correct field label. If not, click 'Cancel”.

P The program will then quickly
import the charts, after which the
process is different depending on if you are bringing in a version
1 or version 2 file. If the following windows appear, you can
follow along. If it’s different, just follow along with the prompts as
they present things to you.

labels, then you click “Import”.

O Save Imported Charts Selection HE h N . d
S e e On this window you
00/29/1065 11:02:00 Y Ponora R UmA so0 [«
0272741995 01°17°00  Mew Fort Beach  CA LA N h . hl . h 11
00/13/1970 08:20:00 Madras India 550 = t t t
00/24/1058 0714600 Mirnecpolis o uzA 5.0 lg lg d € cnarts
0472841051 17:27:00 Los Angeles R U 500
02/28/1832 12:16°00  Rlameda tR R 5 on .
00/05/1960 21:00:00 Madras India 5.50 t Y l k
10719/1958  11:12i00 ¥ Teameck Hew Jersey 500 you want. Ou can Clic
07/0471971 04°30°00 ¥ Sam Francisco  CA O LSA 5 on
05/16/1954 16:44:00  HMirneapolis M UmA 5.00 . h 1.
08/16/1058 07:05:00  Bay City nluzA 500 t t t
05/2041953 0910700 Homolulu HI usA 10,08 once in e 11st an en
05/02/1954 07°03.00 ¥ Boston WA LR 5 on
05/20/1369  16:19:00 1.00 « »
0971941955 13:15:00 ¥ Prinestan M UsA 500 d S l t All d th
05718/1845 053600 Y Pi Has LisA 5 on (0) elecC undaer e
02/26/148 11:55:00 Mo an Erglard 0.00
10/02/1947 17:45:00 usA 5.00 . . .
11710,/1983 _10}23:00 itz 053
Edit menu to highlight
0772071004 05:00:00 Ttaly 0.73
0742141043 2003500 Y Bary M usA e .
05/25/1965 11°20°00  Sant il amn =
s o b e :2 | the whole list. Or you

¥

3 or | Reverse Selection I | Save Selected Charts I Can Command/control
[ Remove selected Lines| [ canceland Enit | Clle on dlfferent ones tO
select various lines.

en they re all s
Selected Charts button




Once you have the charts you want to save all highlighted, you
click the button “Save Selected Charts”, which will actually put
them into the charts file. You will be asked to confirm this action,
just click YES. After it is finished doing that, you will get a
message like this:

Message =]

Despite what it says, some of the Main Chart
%}‘”E‘w";{’”‘v‘“..“ﬂ“"T:m Window options, including the default, do
s ston as you are mere i« || Ot have the button it is referring to. If your
from the efth main chart window that appears has a “Calc”
button, then that is what this is referring to.

You can click that button to calculate all the

charts just imported.
This applies to both versions:

Calculating them all now is one way to go. You can also now just
forget about them until you need them next time, at which point
you could calculate the one you need. The charts have now been
imported and they reside in the charts file, but they are “birth
data only” right now, until you calculate them. So, if in the future,
you double click on one of them in the charts list and yet a chart
fails to appear, then it simply means that you need to calculate
that chart first. Anytime you need to do this just highlight the
chart and click Calc, or the Calculator button, or click Edit and re-
save the chart (same thing).

If you have followed these instructions carefully then you have
exported your charts from one version of Goravani Jyotish and
imported them into another successfully. If you have not had
success at it for some reason, then carefully consider the
following: If you really care about these charts, either make sure
you keep the chart file you created, or, if you are unsure if you
even did that correctly, better save the old version of the Datafile
until you can carry out this process fully.
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Introduction to the use of Goravani Jyotish

It’s all about “the chart”, or “the group of charts”. When you enter
a chart and are viewing it, or when you “pull up a chart” by double
clicking on it in a list of saved charts, you are in both cases
viewing the current chart in memory. Most other features feed off
this chart, usually showing something astrological about that
chart. This is natural, when you’re “on a chart” then all windows
apply to it. Other features deal with the currently selected group
of charts, like by comparing them to each other for example.

Entering charts is as easy as selecting “New” under file or clicking
one of the “New buttons”. You then enter the birth data and click
OK. It’s that simple. There are options, sure, but the main or
default beginners flow of use can be quite simple. Please learn the
simple before you go off into the complex. Learn how to click
New, enter a chart, click OK, let it calculate and appear, and then
maybe select a report to print, then go on to opening other feature
windows and cruising around the program. Mostly astrology is
just a one-entry kind of thing- you enter charts once- you don’t
have to do alot of data entry after that- it's mostly about opening
windows or printouts that show interesting information, which
you then ponder etc., and possibly speak about. So cruising
windows is a big part of it.

Entering Charts

Once you're all installed, go into the program. Pull down File to
New, note the control key, which is N, use it in the future. The new
chart window appears. Type in the first name, tab, last name, tab,
birth date, tab, and so on.



These are the
fields you enter
basic birth data

NT users need to
click this button
to paste in atlas

These other Save Type
buttons you can learn
about later. At first, you
may just want to use the

Birth Dates: When you
enter dates, it’s fairly

flexible- you can use
10/12/1992 or October
12 1992, or 10-12-92 etc.
Try your desired style, it
will probably understand
it. Same with time- just
give it a shot, though
what it’s going to change
things to is like
10/12/1992 and military
time like 13:50:00 for
1:50 PM. Note that the “European” date format is an option under
Prefs Menu (see top of your screen when in the program) under
“Other various prefs”.

DST When you get to DST/WT, don’t enter anything, as it will be
done for you when you tab out of the Country field.

; data if using the OK button which gives
Ic;cl)ljeTtyhpeen(?Acg ACS atlas window you a good, default set
in tandem with GJ of calculated and saved

features to learn with.

Enter a note
optionally, the
field holds huge
notes. It will
always be
stored with the
chart, and is
exported and
imported in V2.1
r—and later- so it's
safe- use it
freely. You can
drag and drop
from the word
processor to
here, so that, if
you write them a
letter, you could
put it in here if

-

Later, you can set up
your favorite groups of
reports and then you
can print them directly
when entering new
charts

Description is
optional-use it for
career names or
notoriety keywords
like “actor”,
“astrologer”, etc.

Enter the City, State (if any), then Country, and TAB.

Tab to leave the country field. The Atlas will be accessed
automatically, and the other longitude, latitude, time zone, and
possibly the DST field should all fill in by themselves. If not, then
type just the first two letters of the city name, and put in the
country, and tab- you'll get a list of cities that start that way, in
that country, and then you can select one.

Basic Chart Entry Checklist: So after the Atlas has been
accessed and filled in, you should have the basics now fully
entered:

@ NAME @ DATE ® TIME

@® LONGITUDE @ LATITUDE @ TIME ZONE

@ ACCURATE ZERO OR ONE IN DST/WT

¥ the description and note fields are optional

After the basics are correct, you just click the OK button. OK
will calculate the chart fully, and find the readings that apply to it,
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and then display the finished chart to you on the main chart
window.

You can take it from there in many directions by accessing
features- cruising the lists that are on the main window, and so
on. Be sure to try everything. Click on buttons, and double-click
on lists. Some of them then do things for you. Try the menus too!

How to use main features

These are some of the main things you’ll see in the program on
different windows. So this is your map of critters that will appear:

List of Charts

There is always a list of charts. You can control whose in it. You
can save lists and bring them up later. You can search for and
bring famous people’s charts and those of cities and countries into
the list. You double click on a chart in the list to bring it up. If
you bring up a chart and there’s nothing there, use Edit and Save
or Calc to Calculate the chart. Remember, double click in this
list.

Planet List

: : =1 | Once a chart is calc’d and saved, it
e reea. wwe el | will have a planet list, which shows
the exact place where each planet
was for the chart, and many other things pertinent to the planets.
This list ACTUALLY CONTAINS ABOUT 10 DIFFERENT LISTS that you can
leaf through one after another, each with it's own list of some key
astrological points. Use the control on the top of the list to leaf
through the other lists which will show here. USE THESE LISTS!
For example, find the one with “velocities” on it. If a planet is
moving slow, like less than .5 normal speed, it’s effects

become strengthened- whatever they may be. Check it out.




[Planet ¥][Gote ¥]Meon-32654ays ~ Dasha List and Controls
c|elo| 1] 2] 3] 4]|3es| 360

Jup  Moon 10/30 /1931 21

Once a chartis calc’d and saved, it

[ »

Jup  Mars  03/01/1983 22 will have a dasha list. These are

Jup  Rahu  02/04/1984 23 | | . .

sat Sat  06s20/1986 26 |=| Vimshottari dashas, the most

Sat  Merc 07/03/1989 29

Sat  Ketu 03/12/1992 31 popular and commonly used type.

Sat  Uen  04/21/1993 32 :

ot on 0o oitioes 3 The start dgtes anq period lo.rds
Moon  06/03/1997 3 are shown in the list along with the

Sat  Mars 01/02/1999 38 )

Sat  Rahu 02/11/2000 39 person s age.

Sat Jup 12/18/2002 42

Merc HMerc 06/30/2005 45 | clelo

Merc Ketu 11/27 /2007 47 I I |

Merc Uen  11/23/2008 48 (o] Takes you to Current,

Moon S nnemarmndt st LD Birth or Entered dates.

)| 1] 2] 2] 4]:

Shows this many levels of dasha.

-—I—'3E'S 2l Switch between the disputed dasha year length.

Planet ¥

Create dasha lists from other planets/cusps.

Goto ¥

Scrolls the list to selected bhukti quickly.

Readings List

LO1INHOF|LO| Wealth
TABLO7 /7 Al Weak Raja on 7 by Aspect

When you save a chart, you can

Iill

EABLO10/64 Weak Raja on 6 by Aspect save a list of readings with it also.
ZABLO9/Z AR Weak Raja on 3 by Aspect .
ZABLO10/34 Weak Raja on 3 by Aspect Readings are placements of

LO2INS/L01{] Strong Karma Dharma Adhi
LO4CJMALILY Separated from Family v

planets, sometimes with an
associated “yoga name”, so this list
shows you the tags representing the placement itself, and the
yoga name is shown. If you click on a line in this list, the text of the
reading will appear in an adjacent little square on the same
window. You can move the vertical divider line to show more or
less information. As you save charts, if you “Save Links” with
them, then the Who button will work by showing you who else
has the same readings as you click through them on the “Who”
window. (for users who want to seriously study the true effects of
readings on multiple charts for persons they know well. This is
the key to learning to read effects.)
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Tags

Tags
I ey [Lhroughout the program these tags are

2ABLO7/74BLO1/ | used. They are shorthand descriptions of
6ABLO10/6ABLO1 /1 Jyotish facts about the chart. They are
ZABLO9/ZABLO1 7 | embedded into the chart in the internal
ZABLO10/3ABLO1 /Nl attributes field, and saved with the chart.
LO2IN2/L010INS/ | There are over 3,000 saved with each chart.
LO4CJMALILO4ABMA They are used to select readings. Readings

require certain placements- example,
“Jupiter in 9 in Sagittarius

and Venus in Aries”- if a reading required these things- then we
would have tagged it this way: /JUPIN9/ARIIN1/VENIN1/ which
is a variation of the original English statement. When you save
readings with a chart, the program compares the tags each
reading requires, and if the required tags are found in the subject
chart’s tags, then the chart gets that reading. In this way, each
chart ends up with an assortment of readings that apply to that
chart. Once you learn the tag shorthand, you can read the tags
very fast-it’s more efficient by far than plain English for this
purpose.

Views "I| Distance V|| < | >

These buttons accompany the planet List. The first two are
menus- pull them down and select lines which will show you
important information about the person’s planets. The next two
gray buttons pointing in opposite directions rotate the list
through the possible choices one at a time, like flipping through
the pages of a book. Be sure to use this feature, it’s very important
(some of the lists) if you are going to learn Jyotish seriously. For
example, one of the lists shows you the speeds the planets were
traveling at when this chart occurred. If a planet is slow, it is more
powerful. This one list is very important for seeing this. And
there’s more...

gpabrahas J | Tol1adhuasd These other two buttons appear in

the planet list on Style A Chart Windows and




they pull up a listing of the shadow planets, or upa Grahas (non-
material planets discussed in the classics), and an important
window which is a listing of how close planets are to the centers
of the houses using both the Sripati and Equal house systems.

F
l&l Here’s the Features !!!

If you use Style A Chart windows, then you will see this button. It
leads to all the many Feature Windows the program offers.

Where are Printouts

Print
If you use Style A Chart windows, then you have the

PRINT button-it brings up a window full of buttons, that lead to
all the many reports and printouts the program offers.

Entering Charts Birth Data

These fields appear when you enter a new chart. Tab to move
through them. Type data into them. The date and time fields
autoformat themselves accepting quite a range of entry styles
including numbers or named months, various abbreviations, the
Enter Birth Data Here then Click 0k US€ of AM and PM or military time.

First | In other words, they’'re smart fields.
The description field is optional, but
if you use it, use it for main

Last |
[rate |

T descriptions of the

City | person such as “Politician”, “Writer”,
o | atias | (s ] [[Hosp etc. Mostly itis used for career or
Country | notoriety issues when it is used with

2o | (Time zones L the includfed fa.mous charil:s. The |
w8 [ 0@N O3 DST./WT flel-d is .for enterlngg 1if
s [0 [ T @ WO daylight saving tl-me or war time was

on. Enter non-adjusted clock on the
wall birth times in the birth time
Description | field- then enter a 1 in DST if it was

on- and the program will adjust. On

time zones, they’re always positive- the program knows it’s East
(a negative time zone) from the West/East radio buttons lower

Gender () Female ) Male
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down on the window. So don'’t try to enter negative time zones.
Male and female selection only affects some readings which are
tagged only for one sex or the other, especially there are a

number of readings just for woman.
City

o [or cmotciy]  USing the Atlas
Country | US4 Enter the City, State (if US or
zone [8.00 Canada ONLY), Country, AND

LLZ:; Ilgll:z g :f g i THEN TAB and the data appears.
Built in 250,000 city atlas, with
complete time change information. You must tab out of the
Country field. Remember that! To search, type 2 letters of the city
only, then the Country and TAB.

x Print Selected Set You'll get a list. Then click one.

Saved Print Sets | CreateNew Set | Drintino sets of reports
Chart and Dashas
Real Complete You can create sets of reports,

choosing from the large master
list. You then see your sets
available on various windows,
such as new chart entry, and multi chart calculation, and multi
chart entry. Wherever you enter or calculate charts, there you
find this option. It is for printing one or more reports
automatically when the save finishes.

ick Full
IM l;l Types of Saves of Charts

You can save a chart with more or less information calculated and
saved. There are many calculations that GJ can perform on a chart
when you enter it and save it. G] gives you control over which
things are calculated. If you just want the basics, why wait for the
Full calculation. So, Quick offers you just the basics, whereas Full
calculates everything about the chart.

|, Ess. Att., & Readings) | Show ATl Choices Chart Save 0pti0nS

[Lauick | [_Fun | [ Funw/ess. att. | These are the buttons available to
you after entering chart birth data.
These are your “Save Options”.

Cancel 0K




The OK button is the normal choice. It saves the chart with all
Jyotish calculations, saves the readings and research attribute
tags. The other optional buttons save other arrangements of these
key components. Quick saves just the basics, Full adds advanced
Jyotish calculations on top of the basics, and Full w/ Essential
saves the chart with all Jyotish calculations, and the research
attribute tags.

| Full w/Ess. Att. I

Attributes are also called tags. These are over 3,000 small strings
of text optionally saved with the chart record. They are used to
gather the readings, and they are used in the Comparing charts
feature. If you ask for Readings along with a chart when saving,
but you don’t ask for the attributes to be saved, they are
calculated anyway, then used to gather the readings, then flushed
before the chart record is actually saved to disk. Those who want
to compare charts should save the attributes, and so may use this
button for this purpose if they don’t want the readings.

Who should Save Attributes

Customizing the Program

GJ] can be customized a number of ways. The customization is
powerful and comprehensive. You can use the Color Picker to
colorize most objects on most windows, choosing from a large
color palette. So you don’t have to accept the way the windows
look. Remember that. Then, you can fully shape, size and
manipulate the Chart Window objects on Chart Style B.
Furthermore, European users can switch the date format to their
way of putting the day first. You can also move windows, stretch
them, then save their placements so that window open where you
want them, and how big you want them. So between colorizing,
window placements, and a fully shape-able main window, the
program is fairly flexible in “personalization”.

Using the Charts List

Like all astrology programs, charts are entered as just a name and
birth details. However, when you Save the chart you are entering,
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GJ] (the program Goravani Jyotish) calculates many things about
that chart and saves those things along with the birth data. So, the
saved chart record is much larger than just birth details. (A legend
of saved record sizes can be found near the end of the manual as
one of the appendices).

All such chart records, entered and saved in the program, are
stored in one large bucket, which is internally known simply as
“the charts file”. You have to separate and search them out of
there when you need them. One way to do that, is just to type part
of a name, hit tab, and let the program pull those up for you. Other
ways are available by clicking some buttons.

On the windows you use in the program, the charts are first
differentiated from each by being grouped into one of four,
namely,

1. Charts, 2. Famous, 3. Archive and 4. Mundane
Charts is where all the charts you enter go

Famous contains 3,200 famous people’s birth data
Archive is where you can send charts to archive them
Mundane holds 1,000 city and country birth data’s
You will see these buttons on windows:

Find in X Chartz [T archive [T Famous [T Mundane

These four classifications determine which charts the other
search functions will access. This is the “primary key” when
doing all chart searches. G] makes managing charts in groups
very possible and easy to do. But with that power comes the price
tag of learning how to use something more than one large list of
charts, which is what GJ had in version 1, and what many other
programs still use. Don’t be put off by the controls please.
Previously I had a simple list- all your charts, all the time, no
controls. Many users asked for “grouping of charts”, so I give you
“saving chart lists” and “grouping by characteristic” as solutions.
Then there’s the issue of providing you with a huge list of famous
charts. So along came the power and features to do it all. Now |



encourage you seriously to learn how to use these many features
and be thus ahead of the curve of those who are not gifted with
the ability to study and focus.

When accessing charts, you are given various buttons and search
features so that you can pull up exactly the chart you are looking
for, whether it’s one you've entered, or some of the famous charts
included with the software. Main Point: To access your charts, you
need only have “Charts” checked. If you want your search to
apply to the famous charts, you need to have “Famous” checked.

How to Access Charts

You will need this as a handy reference, so please keep the
following table around while learning the program. The charts
controls may look different on different windows, but they
function the same. Here are the two ways the chart control are
likely to appear. This is the “Open Charts” window that appears
over main window style A:

Name to Find: |gor | List Al My Charts |

Laak 'inﬁ Charts F Farnous L'istcl 4dd Ta @ Replace I:I
m m | Eirthdates || M-:unthsl | [rescription l

Goravani 0571871960

| Open Saved List | | Sawe This List | | List Charts by attributes | [ List an || | List Recent |

| Select 411 Il Reverse Selection I

| Cancel | (1].4

| Rermowve Selection from List I

And this is the control that appear on other Main Chart Windows:

Find in X Charts [T archive [T Famous [T Mundane
Each Find {® Replaces List ) Adds to List [ Current Dasha
List by first or last names-type |

then tab-first few letters fine

List Al I| List Recent I| Power List Il I
Open List Il Save List I| Remove Il Select All Il Reverse Im
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Either way, the function similarly. Look for the buttons and other
objects in the table below and read about their functionality. You
can refer back to this for guidance as you begin to use the
program and wish to access charts.

Chart List Controls

Look inﬁ Charts Ii Famous

These are the primary filters when
finding charts. Select “Charts” for your charts and also check
famous if you want to check that file when searching. If you don’t
want famous, uncheck it. These affect all other searches. In other
words, if Charts isn’t checked, no matter what you do, your charts
will not appear.

This is the list of charts. The buttons
are for sorting the columns. There is only one such chart list in

memory at a time, but you can save chart lists and pull them up
later. The chart list is saved when you quit, and will reappear
when you come back in. Double click to load a chart. You should
end up having a very easy time getting exactly the charts you
want. After learning these features, you will be able to manage
your charts easily. You should be able to search for people with
certain placements, then after checking them out, pull your main
list of charts right back onto screen for your usual work, then
depart again from the usual pulling up some charts that apply to
some question that just crossed your mind, then moments later
again you're back where you were. Do you get what I'm saying
here? It should end up being an easy and fast experience, but only
after learning what the controls all do.

[ Archive Thisisa place where you can put charts you want to
keep, but wish to move out of your way- get them out of the main
charts file. It's a holding bin. You assign charts to this by using the
Re-File button found on most of the Main Chart windows
including styles C, B, S.

[ Mundane  This is a file of charts for holding charts pertaining to
no-living things such as cities,



countries, and the like. It has 1,000 cities and countries birth
data’s already included for your study.

(® Replaces List When checked, this indicates that you want your

next search to replace the current list.

() Adds to List when checked, this indicates that you want your

next search to add to the current list of charts.

Find: |gor

This is the name typing field. Enter parts of
names. For example, gor (tab) will bring up Al Gore, Das Goravani,
Gorden

Lightfoot (assuming the Fame file is checked). The program uses
what you type here to search both first and last names. Longer
entries narrow the search. Type only one name- DO NOT type first
and last- only one of the other. TAB KEY after you type.

List All My Charts |

This button is simple- it lists only
charts from the charts file- it automatically excludes the other 3
files, namely, famous, mundane and archive. It takes only “charts”
file charts, and lists them all without exception. So, it's an easy
way to get at all your stuff right now.

Astrologer You can assign characteristics to your
charts, such as the words shown at left. You
Cancer )

) enter the words, then you assign each word
Client to any chart anytime you want. As you
Company enter your family members, you can assign
Deceased “family” to them if you wish. You can setup
- 111110% as many characteristics as you like and
HIV assign them to whoever you like. Why do

this? Simple: You can pull up charts by
characteristic. So, at left notice I've selected Family on the menu-
now read below:
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[ then get a list of my family
members because I've linked them
all by simply assigning “family” to
each one of them. Assigning
characteristics therefore is a good
idea because it allows you to
suddenly and easily bring up a list
of charts that share an attribute amongst themselves- anything
you think of- nobody will know what words you enter into your
program- go ahead and call your friends and relatives whatever
you want! Then you can bring up a group and run a Comparison
research run on them to find out what they all share
astrologically.

lﬂl lil etc...

These are sort buttons. They simply sort the list of charts. Also
see the “Sort” menu on some windows.

All| Recentl Searchl

Rev | File |Removel

Open| Savel Sel. All| Thege are the control buttons covered below
as found on the Style B Chart window, which is the customizable
one. Despite their small size and brief

wording, they are in every way the same buttons that [ am about
to cover below, and I think you can tell which one is which once
you are familiar with the concepts of what these list controls do.

S This List :
M This allows you to name and save the current
list of charts. Say you took

time to build a list of all your favorite famous folks. Once you’ve
built the list, what do you do to preserve that work? Save the list.
Name it “Favorite Entertainers” and it will always be there for
you. Use “Open Saved List” to retrieve and use this list at any time
later.

Open Saved List : : )
l—wl This opens lists of charts you’ve saved so that
you can use them again. See the note just above.




List Charts bH Attributes I
M‘ | Seareh| These all the same button. It pops up a

large window with search choices pertaining to charts. You can
search for charts by most basic planetary placements including
house, signs and nakshatras, as well as many other things. It’s a
powerful way to search for an list charts. Go ahead, find out
which famous people have the same Moon as yourself (or any
other planet, ascendant, midheaven, and more....

This button lists all the charts. If you have Charts

checked, then you get all your charts, if you have Famous checked
then you get all the famous charts, which can take a few minutes
to load, and extra memory.

ListRecent ! This lists your recently entered charts or the last
group of famous charts entered if you have that file checked also.

lMl This selects or highlights all the charts currently in
the list. There are a number of things which apply to the charts
highlighted in the list, including deleting and removing, as well as
comparing for research.

Reverse Seleotion This reverses the selected lines in the list.

Selected lines become unselected, and unselected lines become
selected. Lets say you have a list of charts, but only want a couple
of them in the list. So, select those few, then hit this button, and
everything else will be selected, then hit the Remove button and
the highlighted, unwanted charts will be removed from the list.

Remove Selection frrom List

J This removes the selected lines
from the list. It does NOT delete them. It simply removes them
from the list. You will still have the removed charts- they just
won'’t be in the list.
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0K
l_l On the Open Charts window, there is an OK button.

It loads the currently highlighted chart in the list. It’s the same as
double clicking on a chart in the list.

This button allows you to move the charts highlighted in

the list to a different file. For example, you might highlight a
number of your charts and move them to Archive just to get them
out of your way if they are used less often. If you enter some new
famous charts, they will initially go into the Charts file. You may
then highlight them and with this button move them to the
Famous file.

Desc L @O@@OO@®OOLords Studu This strip of controls simply
manipulates the horizontal scrollbar on some of the charts lists.
The colored circle dots represent the planets in order of the days
of the week starting from Sunday. The Desc scrolls you to the
chart description column, the L scrolls you to the Lagna column,
whereas Lords scrolls you to that column.

Jyotish Training Videos

Dancing Moon Inc. also sells a set of three training videos in the
science of Jyotish. These are 2 hours long each for a total of 6
hours of training. They assume no prior knowledge; thus they
begin at the beginning, and help a total beginner get started in
Jyotish. They are narrated by Das Goravani and include many
computer graphics of planets, signs, houses, and photographs, all
as aids to help in the understanding of how Jyotish works. Many
have purchased them and have liked them greatly. These are
separate from the videos which are on the software CD, which
instead deal with the program, not the science of Jyotish.

Font Problems in Windows XP

If the fonts don’t look right on Windows XP, open your Fonts
control panel, by going through the display control panel, and cut



the 3 fonts beginning with the word “Accu” out of the folder, then
paste them back into it. Just cut, then paste. This should correct
the problem. You may have to reboot.

About Calling Us

We, I, am a one-man company. I do many things to run this
company alone. [ am also a bit impaired in terms of nerves and
emotions. So, [ cannot always answer the phone. Try email. I tend
to email better especially if the matter is urgent. Use
das@goravani.com.

Pricing
The software is $295. The demo of it is $10. Upgrades have

generally been $50 to $100 depending on the upgrade. The set of
3 videos on Jyotish is $49 in the US, $64 for PAL version. At this
time (late '04) we still do not have them on DVD, sorry.

How to join the free discussion list

To join the “VALIST”, Vedic Astrology List, send any email to
valist-subscribe@yahoogroups.com. You will be sent further
information by doing this. It’s free. It’s a great learning tool!

Don’t have multiple copies

If you have multiple copies of Omnis 7 and the Goravani program
on your computer, you may run into problems. They might cross-
link to each other and errors will result. So, it's OK to keep your
old datafile, in fact you can use a datafile from 2.26 with this
version 2.5, but don’t keep the rest of the stuff. Have only one
Goravani folder on your machine.

About the book CD

Same thing goes for if you installed the Beneath a Vedic Sky book
CD. If you have that on your machine, get rid of that before
installing this one. Also, the book CD doesn’t work on Windows XP
or 2000. It’s too old.
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About the coming version 3

I am working on Version 3. This will be a major upgrade. You can
see about it on the website http://DancingMoonInc.com

It will run native on OSX. It has many new features. It's a complete
re-write. It’s not at all like the current version. I do not know
when it will be ready, so don’t ask.

Tech Support-what it’s not

It’s not good to think that I can supply a great deal of on the phone
tech support as my nerve condition does not allow that. [ am
usually requiring a great deal of solitude and quiet. I cannot talk
long, and after 20 years of computer work, I hate leading people
through basic things like installation and learning their basic
system. Try to get local help if you are unable to perform basic
tasks. The only phone calls I hope to receive are those for
ordering and getting activation codes, and only short tech support
questions which do not require a great deal of on the phone hand
holding.

800-532-6528 or 541-485-8453

www.goravani.com

das@goravani.com



